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While Deltek has attempted to verify that the information in this document is accurate and complete, 
some typographical or technical errors may exist. The recipient of this document is solely responsible for 
all decisions relating to or use of the information provided herein. 

The information contained in this publication is effective as of the publication date below and is subject to 
change without notice. 

This publication contains proprietary information that is protected by copyright. All rights are reserved. No 
part of this document may be reproduced or transmitted in any form or by any means, electronic or 
mechanical, or translated into another language, without the prior written consent of Deltek, Inc. 

This edition published April 2019. 

© Deltek, Inc. 

Deltek’s software is also protected by copyright law and constitutes valuable confidential and proprietary 
information of Deltek, Inc. and its licensors. The Deltek software, and all related documentation, is 
provided for use only in accordance with the terms of the license agreement. Unauthorized reproduction 
or distribution of the program or any portion thereof could result in severe civil or criminal penalties. 

All trademarks are the property of their respective owners.  
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Deployment Options 
The Deltek Costpoint 7.1 Architecture allows for very flexible and scalable deployment options to meet 
the specific needs of your business. These options include, but are not limited to, multi-tenancy, optional 
components, authentication models, database options, load balancing and fail-over configurations, co-
deployments with Budgeting & Planning and/or Time & Expense, access controls, and many other 
important features to consider. 

Careful consideration of your deployment is an extremely important step in your planning process. Deltek 
has provided many resources to assist you in your deployment planning and implementation process and 
strongly recommends you leverage these resources in order to plan a smooth implementation of your 
Deltek deployment. 

We strongly recommend starting with the document titled 
DeltekCostpoint711DeploymentOptionsTechnicalOverview.pdf, available in Deltek Software Management 
(DSM). The documents listed in the Related Documentation section include numerous important 
documents for you to consider as part of your planning and implementation process. 

Time & Expense 10.0 requires you to carefully consider and choose a deployment option along with your 
Costpoint instance. You now have the following options: 

 Share Everything: Robust model where Costpoint and Time & Expense are deployed as one 
system (one product, one menu), allowing you to leverage your hardware and operational 
investment 

 
 Share Infrastructure: Only share WebLogic deployment 

 Share Nothing: Stand-alone deployment 

Subcontractor (SubK) Management Users 
If you choose to leverage the new Subcontractor Management add-on, you must deploy and configure 
the Share Everything deployment model, where Costpoint and Time & Expense are co-deployed as a 
single system. 

 

Note: Deltek recommends you use this option, which is required for some current and future 
enhancements (for example, you must use this option if you plan to utilize Subcontractor 
Management capability). 
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New Installation Checklist 
The following is a checklist of the overall steps needed to install Time & Expense 10.0.0. Details for each 
step are provided on subsequent pages.  

Print this checklist and use it as you complete this installation, if desired. 

Done? Step Notes 

 

Step summary… Any pertinent notes… 

Pre-Installation 

 1. Costpoint 7.1.1 must be installed and operational.  

 2. All Costpoint 7.1.1 Hot Fixes must be installed.  

Database Tier Installation 

 1. Create Time & Expense 10.0.0 Oracle Instance(s) 
and Tablespaces. 

 

 2. Install Time & Expense 10.0.0 Database using 
Database Tier Installer. 

 

Application Tier Installation  
 1. Install Time & Expense 10.0.0 Application Tier 

Software. 
 

 2. Configure Time & Expense 10.0.0 Access.  

 3. Reinstall Time & Expense 10.0.0 Windows Service.  

 4. Reconfigure Time & Expense 10.0.0 Windows 
Service. 

 

Web Tier Installation (Microsoft IIS) 
 1. Install Time & Expense 10.0.0 Web Tier Software.  

Using Time & Expense 10.0.0 
 1. Set Web Browser Internet Options.  

 2. Log in to Time & Expense 10.0.0.  
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Done? Step Notes 

 3. Install latest Time & Expense 10.0.0 hot fixes.  

Related Documentation 
The following table lists the additional documentation that downloads along with this release. Except 
where noted, all the user guides and quick reference guides listed in this table are also available for 
download from the Deltek Customer Care Connect site. 

You will need Adobe Reader 8.0 or later to view the documents listed in this section. 

Release Notes 

Document Name Description 

Deltek Time & Expense 10.0 Database 
Changes 

This document describes the database changes 
between the release of Time & Expense 9.0.1 and 
Time & Expense 10.0.0. 

Deltek Time & Expense 10.0 Release Notes Major New Features: Click this bookmark to view the 
major new features included in Time & Expense 
10.0.0. 

Enhancements: Click this bookmark to view the 
enhancements included in Time & Expense 10.0.0. 

Known Issues: Click this bookmark to view the 
known issues that are part of the current release of 
Time & Expense 10.0.0. 

Entity Relationship Diagrams (ERDs) 

Document Name Description 

DeltekTimeAndExpense1000TransactionSchemaERD.zip This ZIP file contains the ERD for the 
Deltek Time & Expense 10.0.0 Transaction 
schema. Use index.htm to view the ERD. 

Other Documents 

Document Name Description 

Deltek Costpoint Interface Getting Started 
Guide 

This document describes instructions for accessing 
Time & Expense’s applications as well as 
descriptions of menus, toolbars, and other global 
features. You will also find information on logging on 
to Time & Expense, accessing the database, printing 
reports, reviewing online help, and contacting Deltek 
Customer Care and other client services. 
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Document Name Description 

Deltek Time & Expense 10.0.0 Menu Mapping 
10.0.0 to 9.0.1 

This document describes how the menu selections 
inside Time & Expense 10.0.0 map back to Time & 
Expense 9.0.1. 

Deltek Time & Expense 10.0.0 Menu Mapping 
9.0.1 to 10.0.0 

This document describes how the menu selections 
inside Time & Expense 9.0.1 map to Time & Expense 
10.0.0. 

Deltek Costpoint Interface User Interface QRC This document is a quick reference card which can 
be kept handy and used for reference as you 
navigate Time & Expense 10.0.0. It describes how to 
navigate through the application. 

Deltek Costpoint Interface Shortcut Keys 
Toolbar Icons And Buttons QRC 

This document is a quick reference card which can 
be kept handy and used for reference as you work in 
Time & Expense 10.0.0. It lists the shortcut keys 
available in Time & Expense, as well as the toolbar 
icons and buttons. 

Deltek Costpoint Interface Views QRC This document is a quick reference card which can 
be kept handy and used for reference as you work 
with the Time & Expense 10.0.0. It explains the 
differences between Table View and Form View. 

Deltek Costpoint Interface Query and Lookup 
QRC 

This document is a quick reference card which can 
be kept handy and used for reference as you work 
with the Time & Expense 10.0.0. It explains how to 
use the query and lookup functions in Time & 
Expense. 

Deltek Costpoint Interface Setting Up Printers 
QRC 

This document is a quick reference card which can 
be kept handy and used for reference as you work 
with the Time & Expense 10.0.0. It explains how to 
set up printers. 
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New Installation Overview 
This document provides instructions for installing the Deltek Time & Expense 10.0.0 software. During the 
installation process, you will perform the following: 

 Ensure that your system meets the installation prerequisites. 

 
 Install the Time & Expense 10.0.0 Database Tier software to create your Time & Expense 10.0.0 

Transaction domain. 

 Install the Time & Expense 10.0.0 Application Tier software. 

 Configure Time & Expense 10.0.0 access. 

 Install the Time & Expense 10.0.0 Web Tier software to your Internet Information Server, if 
applicable. 

 

Installation Package Contents 
The Time & Expense 10.0.0 installation package contains the following: 

 Time & Expense 10.0.0 Database Tier installer 

 Time & Expense 10.0.0 Application Tier installer 

 Time & Expense 10.0.0 Web Tier installer 

 Deltek Time & Expense 10.0.0 New Installation Guide for Oracle 

Installation Prerequisites 

Database Tier Installation Prerequisites 
Before you start the Database Tier installation process, your database server must meet the following 
software prerequisites: 

Prerequisite Component Details 

Software All product compatibility information is maintained in the Deltek Product 
Support Compatibility Matrix available on the Customer Care Support 
Site here. 

Passwords To run the installation, a password is required for Oracle SYSTEM and 
SYS users. 

Note: Please refer to the Installation Prerequisites and System Requirements sections for 
additional information. Also please review the full list of Related Documentation prior to 
installing or upgrading to Time & Expense 10.0.0. 

Note: If you need help with this installation, please contact Time & Expense Technical 
Support at 877.HLP.PROJ (877-457-7765). 

https://deltek.custhelp.com/app/answers/detail/a_id/38499
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Prerequisite Component Details 

Oracle Instance and 
Tablespaces 

Create an Oracle instance and Oracle tablespaces as documented in 
the Create Time & Expense 10.0.0 Oracle Instance(s) and Tablespaces 
section. 

Firewall Settings On your Database Server, the Oracle Listener Port (that is, 1521) must 
be open for Inbound and Outbound traffic through your firewall. 

On your Database Server, make sure that Network discovery and file 
sharing options are switched on. 

Oracle The Time & Expense 10.0.0 database user needs the following 
permissions granted: 

 Connect 

 Resource 

 Create Synonym 

 Create Procedure 

 Create View 

 Create Database Link 

 Create Trigger 

 Unlimited Tablespace 

 Unlimited Quota on Underlying Tablespace 

Application Tier Installation Prerequisites 
Before you start the Application Tier installation process, the application server that will run your Time & 
Expense 10.0.0 software must meet the following prerequisites: 

Prerequisite Component Details 

Software All product compatibility information is maintained in the Deltek Product 
Support Compatibility Matrix available on the Customer Care Support 
Site here. 

Costpoint 7.1.1 must be installed and operational. 

All Costpoint 7.1.1 Hot Fixes must be applied. 

Time & Expense 10.0.0 Server Startup Prerequisites 
Before you start Time & Expense 10.0.0, the following must be met: 

Prerequisite Component Details 

Server 

 

Database firewall requirements should be configured. 

https://deltek.custhelp.com/app/answers/detail/a_id/38499
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Prerequisite Component Details 

On your Application Server, the WebLogic Listener Port 7009 must be 
open for Inbound and Outbound traffic through your firewall. 

On your Application Server, make sure that the Network Discovery and 
File Sharing options are switched on. 

Time & Expense 10.0.0 Initial Login Configuration Prerequisites 
Before you can log into Time & Expense 10.0.0, your Windows client computer must meet the following 
requirements: 

Prerequisite Component Details 

Software 

 

All product compatibility information is maintained in the Deltek Product 
Support Compatibility Matrix available on the Customer Care Support 
Site here. 

Adobe Reader 8.0 or later. This is only required for users who want to 
print Time & Expense 10.0.0 reports in PDF format. Make sure that you 
select the Display PDF in browser option under the Preference settings 
for Adobe Acrobat Reader to avoid pulling up a blank IE screen when 
printing in PDF format. 

Web Tier Installation/Microsoft Internet Information Server (IIS) 
Configuration Prerequisites 
The Web server that will host your Internet Information Server software must meet the following 
prerequisites: 

Prerequisite Component Details 

Software 

 

All product compatibility information is maintained in the Deltek Product 
Support Compatibility Matrix available on the Customer Care Support 
Site here. 

Microsoft Internet Information Server 7.0 

Installation Process for Time & Expense 10.0.0 
The Time & Expense 10.0.0 installation process incorporates the following steps:  

Component Change Details 

Database Tier Installation The Database Tier installer creates the following, user defined, user and 
schema: 

 Transaction Schema (that is, TC_0001) 

The Database Tier installer automatically performs all the following 
actions: 

https://deltek.custhelp.com/app/answers/detail/a_id/38499
https://deltek.custhelp.com/app/answers/detail/a_id/38499
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Component Change Details 

 Creating Time & Expense TRANSACTION Database 

 Upgrading Time & Expense SYSTEM Database (if applicable) 

Application Tier Installation The Application Tier installer automatically performs all of the following 
actions: 

 Applying Cleanup_CP_Apps Scripts (if applicable) 

 Applying Menu_data Scripts 

 Applying TC.const Scripts 

 Applying TC.msg Scripts 

 Applying TEESS_Modules Scripts 

 Applying TM.msg Scripts 

 Applying UDT_Templates_Data Scripts 

 Applying UDT_TERMS Scripts 

 Applying TE Metadata Scripts  

Web Tier Installation The Web Tier installer automatically perform all of the following actions: 

 Extracting HelpFiles 

 Resetting Internet Information Server 

Web Servers Supported In Time & Expense 10.0.0 
The Time & Expense 10.0.0 system supports the following Web servers only: 

 Microsoft Internet Information Server 

 Oracle’s WebLogic Web server 

Naming Conventions 
The naming conventions specified in this section are used in all installation instructions detailed in this 
upgrade installation guide. 

Drive Letters 
The table below lists the drive letters used in the installation instructions. 

Drive Description 

C: The drive where the Time & Expense 10.0.0 software is installed. 

Directory Names 
The table below lists the directory names used in the installation instructions. 
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Directory Name Description 

ORACLE/MIDDLEWARE12.1.3 The name of the directory where the Oracle WebLogic software is 
installed. 

DELTEK The name of the directory where the Costpoint 7.1.1 and Time & 
Expense 10.0.0 software is installed. 

Schema Names 
The table below lists the schema names used in the installation instructions. Clients are free to choose 
the schema name. 

Database Name Description 

TC_0001 The name of your Time & Expense 10.0.0 TRANSACTION schema. 

Internet Information 
Software installations, installation instructions, technical guides, and release notes are available for 
download from the Deltek Software Manager (DSM). All future releases of Time & Expense 10.0.0 are 
also downloaded from DSM.  

DSM is the sole download source for hotfix files. Deltek Knowledge Base articles provide an explanation 
of the fixes and contain links to DSM for retrieval of the actual files. 

Deltek Software Manager Requirements 
You can run DSM from any desktop. It does not need run from Deltek application servers.  

In order to run DSM, you must meet the following requirements: 

 Windows XP or later 

 Microsoft .NET Framework 3.5 SP1 (3.5.1) 

The following Deltek Knowledge Base article contains a download link to the framework. It also has 
examples of what you may see if you do not have the framework installed: 
https://deltek.custhelp.com/app/answers/detail/a_id/52469 

 

DSM Documentation and Troubleshooting 

 To view the online help for Deltek Software Manager, click here. 

 To view a tutorial on how to use Deltek Software Manager, click here.  

 To view more information on troubleshooting Deltek Software Manager, click here. 

 

Tip: Refer to the DeltekSoftwareManager.pdf to learn more about DSM and how it works. 

Note: The above troubleshooting link will only work if you are logged into Deltek Customer Care 
Connect. 

https://deltek.custhelp.com/app/answers/detail/a_id/52469
https://dsm.deltek.com/DeltekSoftwareManager/Help/
https://dsm.deltek.com/DeltekSoftwareManager/Tutorial/PubData/Engine/Default.htm?https%3A%2F%2Fdsm.deltek.com%2FDeltekSoftwareManager%2FTutorial%2FPubData%2F
https://deltek.custhelp.com/app/answers/detail/a_id/52469
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Knowledge Base Documentation 

To view Knowledge Base articles: 

1. Go to http://www.deltek.com and click Support Login. 

2. Enter your logon credentials in the following fields and click Log In: 

Field Name Description 

Username Your Support user name 

Password Your Support user password. 

If you have forgotten your username or password, click Account Assistance.  

 If you have forgotten your username, enter your email address and click Email My 
Username.  

 If you have forgotten your password, enter your username and click Reset My Password. 

3. On the Deltek Support Home Screen, click the Knowledge Center tab, and complete the following 
fields: 

Field Name Description 

Refine by Product Select Time & Expense from the drop-down list. 

Refine by 
Category/Version 

Expand Service Pack / Hot Fix from the drop-down list and select 
10.0.0. 

Search Type Use the default value, Phrases, or select your preferred search type 
from the drop-down list. 

Search by Keyword Enter the specific text you are looking for or leave blank to return all 
records for this version. 

4. Click Search. 

5. On the search results screen, perform the following actions: 

a. In the Summary column, click the link for the desired correction. 

b. When the desired correction loads, click the links in the Answers section to download the 
files. 

System Requirements 
The Time & Expense 10.0.0 system uses the following components: 

 Database Tier: Oracle 

 Application Tier: With integrated WebLogic Server 

 Browser Client: Internet Explorer, Chrome, Firefox, Safari 

 Web Tier: Microsoft Internet Information Server (optional) 

http://www.deltek.com/
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 All product compatibility information is maintained in the Deltek Product Support Compatibility 
Matrix available on the Customer Care Support site here. 

 

 
For the most current hardware and software requirements, please refer to the Knowledge Base article 
containing the Compatibility Matrix: 

 https://deltek.custhelp.com/app/answers/detail/a_id/38499 

 https://deltek.custhelp.com/ci/fattach/get/1072689/0/filename/DeltekProductSupportCompatibility
Matrix.pdf 

Time & Expense 10.0.0 Log File Information 
The table below provides information on the log files used by the Time & Expense 10.0.0 system. All of 
these log files are located on the Application Server under the C:\Deltek\Costpoint\71\logs folder. 

File Name Description 

DEServer.log This log file is maintained by the WebLogic server instance. In a 
clustered environment, each server will write to a separate file and 
the file name matches the server name. The log records server-
specific events such as the startup and shutdown of servers, the 
deployment of new applications, or the failure of one or more 
subsystems. The messages include information about the time and 
date of the event as well as the ID of the user who initiated the 
event. 

CP_DBConn_DEServer.log This file lists the active connections used by the product at a given 
time. To enable this logging, set 
<SYSTEMNAME>.logDBConnectionProfile = true in enterprise 
properties. In a clustered environment, each server will write to a 
separate log file and the name of the server will determine the 
name of the log file. CP_DBConn_<Server>.log 

CP_DEServer.log This log file contains application specific information such as 
performance, security, and errors encountered while running a 
Costpoint application. Each server will write to a separate log file 
and the name of the server will determine the name of the log file. 
CP_<Server>.log. 

CP_Security_DEServer.log This file captures messages generated by the Costpoint Web 
security module. Messages such as invalid login attempt due to 
user id, password, insufficient parameters, and deactivated user 

Note: For the Time & Expense system to function properly, the system clocks on your WebLogic 
application server and the database server that hosts your Time & Expense databases must be 
synchronized with each other. Failure to synchronize your system clocks may result in login and other 
system problems. 

Note: A hardware recommendations document should have previously been distributed to you. For 
future releases of Time & Expense, hardware recommendations will be supplied via a Customer Care 
Knowledge Base article. 

https://deltek.custhelp.com/app/answers/detail/a_id/38499
https://deltek.custhelp.com/app/answers/detail/a_id/38499
https://deltek.custhelp.com/ci/fattach/get/1072689/0/filename/DeltekProductSupportCompatibilityMatrix.pdf
https://deltek.custhelp.com/ci/fattach/get/1072689/0/filename/DeltekProductSupportCompatibilityMatrix.pdf
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File Name Description 

account are captured here. In a clustered environment, each server 
will write to a separate log file and the name of the server will 
determine the name of the log file. CP_Security_<Server>.log. 

delteke.log This log file contains information that pertains to the entire domain. 
It consolidates log records from all application logs and a subset of 
events recorded in all server logs. All the information gathered is 
written into a single file. 

Note: Not all log messages are written into domain. Only those 
messages that match the defined severity are consolidated. 

service.log This log file contains messages generated by the Costpoint Web 
windows service. It helps in troubleshooting issues related to 
service startup, which usually occur during the initial configuration 
stages. In addition to service-related messages, it also contains 
most of the information that is captured in the DEServer.log. So, 
once the initial startup issues are sorted out, it is suggested to 
disable this log by editing the InstallCPWebasService.cmd 
(C:\Deltek\Costpoint\71\bin folder), removing the occurrence of "-
log:%CP_ROOT%\logs\service.log". If you remove this after 
installing the service, you will need to uninstall and reinstall the 
service for the changes to take effect. 
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Pre-Installation Instructions 
This section provides instructions for requirements prior to installing Time & Expense 10.0.0. 

During the pre-installation steps, you will perform the following actions: 

 Install and configure Costpoint 7.1.1. 

 Apply the latest Costpoint 7.1.1 hot fixes. 

Install and Configure Costpoint 7.1.1 
Time & Expense 10.0.0 runs on the Costpoint 7.1.1 framework. So before you can install Time & Expense 
10.0.0, you must install Costpoint 7.1.1. 

If you do not already have a functioning Costpoint 7.1.1 environment, follow the appropriate installation 
document to install Costpoint 7.1.1: 

 DeltekCostpoint711NewInstallationForOracle.pdf 

 DeltekCostpoint711UpgradeInstallationForOracle.pdf 

Once you have a functioning Costpoint 7.1.1 environment, accomplish the next step below, Apply Latest 
Costpoint 7.1.1 Hot Fixes. 

Apply Latest Costpoint 7.1.1 Hot Fixes 
Time & Expense 10.0.0 requires all Costpoint 7.1.1 hot fixes to be applied prior to installing Time & 
Expense 10.0.0. 

Once you have a functioning Costpoint 7.1.1 environment, follow the appropriate installation document to 
install the latest Costpoint 7.1.1 framework update and all downloaded hot fixes: 

 DeltekCostpoint711FrameworkUpdateInstallation.pdf 

 DeltekCostpoint711DeployingHotFixes.pdf 

 
Once you have the latest Costpoint 7.1.1 framework update installer loaded and have applied all 
Costpoint 7.1.1 hot fixes, go to the next section, Database Tier Installation. 

Warning: Costpoint 7.1.1 Framework Update MUST be installed BEFORE installing Costpoint 7.1.1 
Hot Fixes. Costpoint 7.1.1 Hot Fixes MUST be installed BEFORE installing Time & Expense 10.0.0. 
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Database Tier Installation 
This section provides instructions and recommendations for creating your Time & Expense 10.0.0 
Transaction schema. 

During this installation process, you will install the Time & Expense 10.0.0 Database Tier software to 
create and populate a Time & Expense 10.0.0 Transaction database schema where transactional data 
will be stored. 

 

Before You Start 
Make sure that you meet all Database Tier Installation Prerequisites. 

Create Time & Expense 10.0.0 Oracle Instance(s) and 
Tablespaces 
The recommended steps to configure your Oracle instance(s) and set up your Time & Expense 10.0.0 
database tablespaces are detailed in this section. 

This step must be performed on the Oracle database server that will host your Time & Expense 10.0.0 
TRANSACTION database schema (TC_0001). 

To create the instance(s) and tablespaces that will host your TC_0001 database schema: 

1. Use your Oracle database software to create an Oracle instance for hosting the Time & Expense 
database. 

The following tables provide a reference for creating your Oracle instance(s). 

These initial settings are only minimal recommendations. Your production environment may need 
to be analyzed and adjusted to meet your specific requirements. You must customize these 
parameters over time based on database size, concurrent users, workload, and so on, to achieve 
optimal performance. 

Oracle Instance Parameter Value 

cursor_sharing EXACT 

db_block_size 8192 

dml_locks 1500 

java_pool_size 32 MB 

job_queue_processes 2 

log_checkpoint_interval 10000 

Note: If you use Oracle Real Application Clusters (RAC) and you have two or more Oracle instances, 
make sure that your Costpoint 7.1.1 TRANSACTION, ADMIN, and SYSTEM schemas are all part of 
one RAC database instead of physically separate databases. If you have a critical need to use 
separate databases, please contact Deltek Support. 
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Oracle Instance Parameter Value 

log_checkpoint_timeout 1800 

open_cursors 2000 

optimizer_index_caching 90 

optimizer_index_cost_adj 25 

optimizer_mode ALL_ROWS 

processes 500 

session_cached_cursors 1500 

timed_statistics TRUE 

sga_target 0 

pga_aggregate_target 0 

statistics_level Typical 

db_file_multiblock_read_count 16 

memory_target Based on database size (1 GB to 15 GB) 

memory_max_target Based on database size (1 GB to 15 GB) 

pga_aggregate_limit (12c only) 0 

 
 

Tablespace 
Configuration 
Type 

Tablespace Name Minimum 
Size (MB) 

Small Production System (MB) 

System SYSTEM 100 100 

Default TE_DATA 200 500 

Index TE_INDEX 100 300 

Temporary TEMPORARY_DATA 100 400 

2. For databases over 2GB, Deltek recommends creating multiple datafiles for each of the 
tablespaces mentioned above for optimal configuration and performance. 
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Configuring Costpoint on Oracle 
Time & Expense 10.0.0 supports both Oracle database architectures - non-CDBs as well as Oracle 
Multitenant (PDBs). 

Time & Expense 10.0.0 fully supports use of pluggable databases (PDBs) that form a part of a container 
database (CDB). When hosting a Time & Expense database as a PDB, it is important to allocate 
adequate shared resources and/or limit the number of PDBs in the CDB in order to achieve and maintain 
optimal application performance. The database setup and configuration with Oracle multitenant will vary 
depending on the database workload characteristics, database size, concurrent users, and so on. 

 

Install Database Tier Software 
The steps to install the Time & Expense 10.0.0 Database Tier software as well as create the Transaction 
schema are detailed in this section. 

You must perform this step on your database server or from a client workstation with Oracle client 
connectivity tools installed to connect to the database.  

You must have Internet access on the machine where the Time & Expense 10.0.0 installer is invoked in 
order to automatically download the latest DeltekTimeAndExpense1000DatabaseUpgradeFiles.exe and 
Deltek TimeAndExpense1000RequirementsINI.exe files automatically. The 
DeltekTimeAndExpense1000DatabaseUpgradeFiles.exe contains the latest database patch rollback 
scripts as well as the latest list of Time & Expense 9.0.1 database patches that have been worked into the 
upgrade. The TimeAndExpense1000RequirementsINI.exe contains the latest OS platforms and database 
versions supported. These files are automatically downloaded when you launch the Database Tier 
installation, assuming that your database server has Internet access.  

 
If your database server does not have Internet access, you will need to perform the steps in the Latest 
Upgrade Files Download section of this document before you run the 
DeltekTimeAndExpense1000DatabaseTier.exe file. 

To install the Database Tier software: 

1. Run the DeltekTimeAndExpense1000DatabaseTier.exe file to launch the Time & Expense 
10.0.0 Database Tier installation program. The Welcome to the Time & Expense 10 Installer 
screen displays. 

 
2. Click Next >.  

Note: Costoint 7.1.1 does not support use of domain name suffixed to the Oracle service name. For 
example, Costpoint 7.1.1 does not support orc1.domain.com as your service name. 

Note: The Deltek product installers contain functionality which enables them to dynamically download 
configuration files and patch rollback scripts when the product installers are executed from the Deltek 
Software Manager server.  To improve security, these connections have been modified to require 
communication over HTTPS. 

Note: Due to enhanced security in Microsoft Windows Server 2012, it is advised that you use 
the Run as Administrator option when launching installation files, even if you are logged in 
as a user with local administrative rights. To Run as Administrator, right-click the installer 
file in Windows Explorer and select Run as Administrator. 
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3. On the License Agreement screen, review the license agreement, select the I accept the terms 
of the license agreement check box, and click Next >.  

4. On the Choose Time & Expense Database Scripts Directory screen, click Browse to navigate to 
an installation location for the Time & Expense 10.0.0 Database Tier software. The default 
installation location is C:\Program Files\Deltek\Time & Expense\10.0.0 (recommended). Click 
Next >.  

5. On the Select Deltek Time & Expense Install Type screen, select New Install and click Next >. 

6. On the Select Database Platform screen, select Oracle and click Next >.  

7. On the Select Oracle Home screen, from the drop-down list, select the Oracle Home location for 
your Time & Expense database. The installer will read your registry to display all available Oracle 
Home locations. Click Next >.  

8. On the Deltek Time & Expense 10.0.0 Transaction Oracle Database Information screen, 
complete the following: 

Field Name Action 

IP Address or 
Hostname 

Enter the IP address (for example, 10.2.2.154) or hostname (for example, 
dbsvr01) of your Time & Expense 10.0.0 Transaction database server. 
The default value is your computer name. 

The values for the IP Address or Hostname cannot be 127.0.1.0.1 or 
localhost. 

For RAC installations, you must specify the IP Address or Hostname of 
one of the instances. If you have SCAN listener set up, please use the 
Scan hostname or Scan IP Address. Do not use the Virtual IP Address. 

Port Enter the Oracle listener port of your Time & Expense 10.0.0 database 
server. The default port for Oracle is 1521. 

SID/SERVICE 
NAME 

Select SID or SERVICE NAME and enter the system identification name 
(SID) or Service Name (ORC1) for the Oracle instance where your Time 
& Expense 10.0.0 Transaction database schema will be created. The 
default is ORC1.  In addition to standard alphanumeric characters, the 
following special characters are also supported: 

$ - _  

Please note a . (period character) is not supported as part of the 
Service Name. 

For databases on Oracle 12c, Service Name must be selected. 

For databases on other Oracle versions, you can choose either the SID 
or the Service Name to connect to the Time & Expense 10.0.0 database. 
The Oracle SID pertains to the unique name that identifies an Oracle 
instance. If SID is used, then the SID must be registered with the listener 
on the database server hosting the Time & Expense 10.0.0 database. 

Similarly, if a Service Name is entered, the Service Name must be a 
valid service registered with the listener on the database server hosting 
the Time & Expense 10.0.0 database. 
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Field Name Action 

For RAC installations, you may specify the Oracle Instance (SID) of one 
of the instances, or use the Service Name depending on your Oracle 
RDBMS version. 

User Name Enter the name for your Transaction schema user account. The default is 
TC_0001.  In addition to standard alphanumeric characters, the following 
special characters are also supported: 

$ - _  

Password Enter the password for your Transaction schema user account.  In 
addition to standard alphanumeric characters, the following special 
characters are also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

Confirm Password Reenter the password for your Transaction schema user account.  In 
addition to standard alphanumeric characters, the following special 
characters are also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

Oracle SYSTEM 
Schema Password 

Enter the password for your Oracle SYSTEM user account.  In addition to 
standard alphanumeric characters, the following special characters are 
also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

9. Click Test Connection. If you have entered the proper database connection information,  a 
message similar to the following displays:  

 “User TC_0001 will be created. Click Next.” 

If the message above does not display, correct the connection information and click Test 
Connection again. 

10. After the “User TC_0001 will be created. Click Next.” message displays, click Next >. The 
Select Time & Expense Tablespace Information screen displays. 

11. Complete the following fields: 

Field Name Action 

Default Select your default tablespace for the Time & Expense Transaction 
schema. Deltek recommends creating Oracle tablespace called 
TE_DATA and selecting it here. 

Temporary Select your temporary tablespace for the Time & Expense Transaction 
schema. Deltek recommends creating Oracle tablespace called 
TEMPORARY_DATA and selecting it here. 

Index Tablespace Select your index tablespace for the Time & Expense Transaction 
schema. Deltek recommends creating Oracle tablespace called 
TE_INDEX and selecting it here. 
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12. Click Next >.  

13. On the Pre-Installation Summary screen, review the installation parameters you selected: 

 If you want to change any settings, click < Back to go back and make the necessary 
changes.  

 If you are satisfied with these settings, click Install > to begin the installation. 

Once initiated, the installation process will commence and create objects needed for Time & 
Expense 10.0.0. Please do not interrupt the process. A Windows Command Prompt will appear 
on your screen that displays the scripts that are being executed. 

The installation will perform the scenarios detailed in the Installation Process for Time & Expense 
10.0.0 section of this document. The installation process will stop if any errors are encountered. If 
any errors occur during the installation, please refer to the Troubleshooting Instructions section of 
this document. 

14. On the InstallShield Wizard Complete screen, select the Yes, I want to view the log file check 
box to open the DeltekTimeAndExpense1000DatabaseTierInstallLog_<date>_<time>.txt file from 
the C:\Program Files\Deltek\Time & Expense\10.0.0\Logs directory. This check box is selected by 
default. 

15. Click Finish to exit the installation. 

16. When the DeltekTimeAndExpense1000DatabaseTierInstallLog_<date>_<time>.txt file opens, 
search for the following keywords: 

 “Error”: Report any search results to Deltek Time & Expense Technical Support. 

 “Database Installation For New Time & Expense 10.0.0 Completed Successfully” and 
then the line “$DBSUCCESS=TRUE”. 

Finding the last item listed above indicates that you successfully installed the Time & Expense 
10.0.0 Database Tier software and that you created your schema successfully. 

Make sure that the default Oracle Port, 1521, is open for Inbound and Outbound traffic through 
your firewall. Also, make sure that Network Discovery and File Sharing options are switched on. 
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Application Tier Installation 
The Time & Expense 10.0.0 system uses Oracle’s WebLogic Server 12.1.3 and Costpoint 7.1.1 for its 
application server tier. During the Application Tier installation process, you will install the Time & Expense 
10.0.0 software. 

As previously mentioned in the Pre-Installation Instructions section, the Time & Expense 10.0.0 WebLogic 
application server must already contain WebLogic Server 12.1.3 and Costpoint 7.1.1. 

Before You Start 
Make sure that you meet all Application Tier Installation Prerequisites. 

Install Application Tier Software 
This step provides instructions for installing the Deltek Time & Expense 10.0.0 software. 

You must perform this step on the machine that will serve as your Time & Expense 10.0.0 application 
server. 

You must have Internet access on the machine where the Time & Expense 10.0.0 installer is invoked in 
order to download the latest DeltekTimeAndExpense1000RequirementsINI.exe file automatically. The file 
contains the latest OS platforms and database versions supported. The file is automatically downloaded 
when you launch the Application Tier installation, assuming that your application server has Internet 
access.  

 
If your application server does not have internet access, you will need to perform the steps in the Latest 
Upgrade Files Download section of this document before you run the Deltek 
TimeAndExpense1000ApplicationTier.exe file. 

To install the Application Tier software: 

1. Run the DeltekTimeAndExpense1000ApplicationTier.exe file to launch the Time & Expense 
10.0.0 Application Tier installation program. The Welcome to the Time & Expense 10 Installer 
screen displays. 

 
2. Click Next >.  

3. On the License Agreement screen, review the license agreement, select the I accept the terms 
of the license agreement check box, and click Next >.  

4. On the Select Deltek Costpoint 7.1.1 Installation Directory screen, navigate to the location where 
your Costpoint 7.1.1 software is installed. The default directory is C:\Deltek (recommended). 

Note: The Deltek product installers contain functionality which enables them to dynamically download 
configuration files and patch rollback scripts when the product installers are executed from the Deltek 
Software Manager server.  To improve security, these connections have been modified to require 
communication over HTTPS. 

Note: Due to enhanced security in Microsoft Windows Server 2012, it is advised that you use 
the Run as Administrator option when launching installation files, even if you are logged in 
as a user with local administrative rights. To Run as Administrator, right-click the 
DeltekTimeAndExpense1000ApplicationTier.exe file in Windows Explorer and select Run as 
Administrator. 
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5. Click Next >. 

6. On the Select Deltek Costpoint System Name screen, select the Costpoint System you will be 
using to connect to Time & Expense 10.0.0. Click Next >. 

7. On the Select Database Platform screen, select Oracle. Click Next >.  

8. On the Deltek Costpoint 7.1.1 System Oracle Database Information screen, complete the 
following fields: 

Field Name Action 

IP Address or 
Hostname 

Enter the IP address (for example, 10.2.2.154) or hostname (for example, 
dbsvr01) of your Costpoint 7.1.1 SYSTEM (CPSYSTEM) database 
server. The default value is your computer name. 

The IP Address or Hostname cannot be 127.0.1.0.1 or localhost. 

For RAC installations, you must specify the IP Address or Hostname of 
one of the instances. Do not use the Virtual IP Address. 

Port Enter the port that your Costpoint 7.1.1 SYSTEM database server 
software uses to listen for requests. The default port for Oracle is 1521. 

SID/Service Name Enter the service name (ORC1) for the Oracle instance where your 
Costpoint 7.1.1 SYSTEM (CPSYSTEM) database schema resides. The 
default value is ORC1.  In addition to standard alphanumeric characters, 
the following special characters are also supported: 

$ - _  

The Service Name must be a valid service registered with the listener on 
the database server hosting the Costpoint database.  The Oracle Net 
Connect Descriptor on the client machine uses "Service_Name" in the 
instance portion to specify the database to connect to in the file 
tnsnames.ora. 

Oracle creates one default service with the same name as the SID when 
a database is created. This service registers with the local listener to 
provide access to the database. Customers can choose to create other 
service names as needed. 

For RAC installations, you must specify the Service Name of one of the 
instances. 

User Name Enter the name your CPSYSTEM user. The default user is CPSYSTEM.  
In addition to standard alphanumeric characters, the following special 
characters are also supported: 

$ - _  

Password Enter the password for your CPSYSTEM user.  In addition to standard 
alphanumeric characters, the following special characters are also 
supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 



Application Tier Installation 

New Installation Guide for Oracle® 22 

 

Field Name Action 

Oracle SYSTEM 
Schema Password 

Enter the password for your Oracle SYSTEM user account.  In addition to 
standard alphanumeric characters, the following special characters are 
also supported: 

‘ ~ # $ ^ & ( ) - _ + = , . 

9. Click Test Connection. If you entered the proper database connection information, then the 
following message displays: “Connection Successful. Click Next.”  

If this message does not display, correct the information entered and click Test Connection 
again.  

After the “Connection Successful. Click Next.” message displays, click Next >.  

10. On the Choose Deltek Time & Expense License File screen, click Browse to navigate to the 
Deltek-supplied Time & Expense 10.0.0 LICENSE.ZIP file. Click Next >. 

11. On the Pre-Installation Summary screen, review the installation parameters you selected: 

 If you want to change any settings, click < Back to go back and make the necessary 
changes.  

 If you are satisfied with these settings, click Install > to begin the installation. 

Once initiated, the installation process can take a long time to complete. Please do not interrupt 
the process. A Windows Command Prompt will also appear on your screen that displays the 
scripts that are being executed. 

The installation will perform the scenarios detailed in the Installation Process for Time & Expense 
10.0.0 section of this document. The installation process will stop if any errors are encountered. If 
any errors occur during the installation, please refer to the Troubleshooting Instructions section of 
this document. 

12. If there were any errors, the log file  
DeltekTimeAndExpense1000ApplicationTierInstallLog_<date>_<time>.txt (from the 
C:\Program Files\Deltek\Time & Expense\10.0.0\Logs directory) will open. 

13. The following message displays: 

 
This is just a reminder that there are other steps in this installation document that still need to be 
performed. Click OK. 

14. When the installation has completed, the InstallShield Wizard Complete screen displays, 
indicating it “… successfully installed Time & Expense 10.0…”. 
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Perform the following: 

 Yes, I want to restart my computer now: Select this option to reboot your Application 
Server. This option is selected by default. 

 Click Finish to exit the installation and reboot your Application Server. 

15. Once your Application Server has rebooted, open the  
DeltekTimeAndExpense1000ApplicationTierInstallLog_<date>_<time>.txt file from the 
C:\Program Files\Deltek\Time & Expense\10.0.0\Logs directory. 

16. When the DeltekTimeAndExpense1000ApplicationTierInstallLog_<date>_<time>.txt file 
opens, search for the following keyword: 

 “Error”: Report any search results to Deltek Costpoint Technical Support. The following error 
messages can be ignored: 

 OnInstallingFile - Installing: C:\Deltek\Costpoint\71\applications\enterprise\APP-
INF\classes\com\deltek\enterprise\application\te\ad\commonad\importengine\ImportError
StatusCodes.class 

 OnInstallingFile - Installing: C:\Deltek\Costpoint\71\applications\enterprise\APP-
INF\classes\com\deltek\enterprise\application\te\commontc\utils\ErrorCodes.class 

Configure Time & Expense 10.0.0 Access 
The steps to configure your Costpoint 7.1.1 system to recognize Time & Expense 10.0.0 are detailed in 
this section. 

You must perform this step on your Costpoint 7.1.1 WebLogic application server. 
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To configure Time & Expense 10.0.0: 

1. With your Costpoint 7.1.1 service running, click Start » All Programs » Costpoint 7.1.1 » Start 
Costpoint 7.1.1 Config Utility. For Windows Server 2012, right-click Start and select Search. 
Under Costpoint 7.1.1, right-click Start Costpoint 7.1.1 Config Utility, and click Run as 
administrator. 

 
2. On the Select Your Configuration Options screen, make sure the Product Application 

Configuration check box is selected and click Next. 

3. The following message displays: 

 
This will be cleared once the changes about to be made are saved. Click OK. 

4. On the Costpoint Configuration Utility screen, perform the following: 

a. Click the Product tab. 

b. On the Displaying System field, select the Costpoint System that you are configuring for 
Time & Expense 10.0.0 (that is, DELTEKCP) from the drop-down list. 

c. Click the System tab. 

d. In the Products Installed group box, select the TEESS check box. 

e. In the Settings group box, make sure the Production Mode check box is selected. 

Note: Due to the enhanced security in Windows Server 2012, it is advised to that you use the 
Run as Administrator option when launching this command even if the logged in user has 
local administrative rights. 
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5. On the Costpoint Configuration Utility screen, select the TEESS tab and perform the following: 

Field Name Action 

Database Vendor Select Oracle. 

Host Enter the IP address (for example, 10.2.2.154) or hostname (for example, 
dbsvr01) of your Time & Expense 10.0.0 TRANSACTION (TC_0001) 
database server. The default value is your computer name. 

The IP Address or Hostname cannot be 127.0.1.0.1 or localhost. 

For RAC installations, you must specify the IP Address or Hostname of 
one of the instances. Do not use the Virtual IP Address. 

Port Enter the port that your Time & Expense 10.0.0 TRANSACTION 
database server software uses to listen for requests. The default port for 
Oracle is 1521. 

Service Name Enter the SID/service name (ORC1) for the Oracle instance where your 
Time & Expense 10.0.0 TRANSACTION (TC_0001) database schema 
resides. The default value is ORC1. 

User Enter the name of your Time & Expense 10.0.0 TRANSACTION user. 
The default user is TC_0001. 

Password Enter the password for your TC_0001 user. 

Confirm Password Reenter the password for your TC_0001 user. 
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Field Name Action 

URL Accept the default. 

6. Click Test. The following message displays: 

 
7. Click OK. If you were unable to connect, review the information entered and try again. 

8. On the Costpoint Config Utility screen, click Save. The following message displays: 

 
9. Click OK, and click Close. 

Reinstalling Costpoint 7.1.1 Windows Service 
This step provides instructions for reinstalling the Costpoint 7.1.1 Windows service. 

This step must be performed on your Costpoint 7.1.1 WebLogic application server. 

To reinstall Costpoint 7.1.1 to run as a Windows service: 

1. Click Start » Administrative Tools » Services. 

2. On the Services window, scroll down the Services list, right-click the Costpoint 7.1.1 service, 
and click Stop. 

3. Use Windows Explorer to navigate to the directory where the Costpoint 7.1.1 software was 
installed (C:\Deltek\Costpoint\71\bin).  

4. Right-click InstallCPWebasService.cmd, and select Run as administrator. 

Reconfiguring and Starting Costpoint 7.1.1 Windows Service 
This step provides instructions for reconfiguring and starting the Costpoint 7.1.1 Windows service. 

 
This step must be performed on your Costpoint 7.1.1 WebLogic application server. 

Warning: Reinstalling the Costpoint 7.1.1 Windows service above means you need to reset or 
reconfigure all settings you initially had configured with your Costpoint 7.1.1 Windows service. 
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To reconfigure Costpoint 7.1.1 Windows service: 

1. Click Start » Administrative Tools » Services. 

2. On the Services window, scroll down the Services list, right-click the Costpoint 7.1.1 service, 
and click Properties on the shortcut menu. 

 
3. On the Costpoint 7.1.1 Properties screen, click the Recovery tab, and perform the following: 

Option Description 

First failure Change the drop-down selection from Take No Action to Restart 
the Service. 

Second failure Accept the default value, Take No Action. 

Subsequent failures Accept the default value, Take No Action. 

Reset fail count after Change from 0 to 1 days. 

Restart service after Accept the default of 1 minute. 

4. Click Apply. 

5. On the Costpoint 7.1.1 Properties screen, click the Log On tab and complete the following: 

Field Name Action 

Account Enter the domain Account (for example,  domain\useraccountname). 

If using a domain service login account instead of using the "Local 
System Account", select This Account. 

Password Enter the password for the domain Account. 

Confirm Password Reenter your password for the domain Account. 

6. Click Apply. Make sure that the login account for the Costpoint Service is in the local 
Administrators group on the Application Tier server.  

Also, keep in mind that this login account must be given full access permissions for any Alternate 
File locations setup (network shared directories). Alternate file locations are used for Costpoint 
users for uploading and downloading files from within Costpoint.   

7. On the Costpoint 7.1.1 Properties screen, click the General tab, and click Start to start the 
Costpoint 7.1.1 service. 

Note: If you do not find the Costpoint 7.1.1 service, it must not have installed properly in the 
previous step. Please go back and try that step again. 
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8. Click OK to close the Costpoint 7.1.1 Properties screen. 

9. Close the Services window. 

 

Note: The service will immediately indicate that it has started. However, please note that it 
takes several minutes for the Costpoint 7.1.1 service to fully initialize. 

After you have started the service, wait several minutes before attempting to connect to the 
software. 

If you encounter problems with the Costpoint 7.1.1 service, check the 
C:\Deltek\Costpoint\7.1.1\logs\DEServer.log file and report any errors to Deltek Costpoint 
7.1.1 Technical Support. 
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Web Tier Installation 
The steps to integrate your Time & Expense 10.0.0 software with the Microsoft Internet Information 
Server (IIS) is detailed in this section. 

The Microsoft Internet Information Server component is optional. The WebLogic Server software 
included an integrated Web server component that you can use with the Time & Expense 10.0.0 
software. 

Though the use of the IIS component is optional, Deltek strongly recommends that you install it in your 
production environment. In addition to acting as the proxy, the IIS server is also used to load balance the 
cluster nodes. 

Before You Start 
Make sure that you meet all Web Tier Installation (Microsoft IIS) Prerequisites. 

Install Web Tier Software 
The steps to integrate the Time & Expense 10.0.0 system with Microsoft IIS are detailed in this section. 

You must perform this step on a Web server that is using Microsoft Internet Information Server. 

You must have Internet access on the machine where the Time & Expense 10.0.0 installer is invoked in 
order to download the latest DeltekTimeAndExpense1000RequirementsINI.exe file automatically. The file 
contains the latest OS platforms and database versions supported. The file is automatically downloaded 
when you launch the Web Tier installation, assuming that your application server has Internet access.  

 
If your application server does not have internet access, you will need to perform the steps in the Latest 
Upgrade Files Download section of this document before you run the Deltek 
TimeAndExpense1000WebTier.exe file. 

To install Time & Expense 10.0.0 on your Microsoft IIS Web server: 

1. Run the DeltekTimeAndExpense1000WebTier.exe file to launch the Time & Expense 10.0.0 
Web Tier installation program. The Welcome to the Time & Expense 10 Installer screen displays. 

 
2. Click Next >.  

3. On the License Agreement screen, review the license agreement, select the I accept the terms 
of the license agreement check box, and click Next >.  

Note: The Deltek product installers contain functionality which enables them to dynamically download 
configuration files and patch rollback scripts when the product installers are executed from the Deltek 
Software Manager server.  To improve security, these connections have been modified to require 
communication over HTTPS. 

Note: Due to enhanced security in Microsoft Windows Server 2012, it is advised that you use 
the Run as Administrator option when launching installation files, even if you are logged in 
as a user with local administrative rights. To Run as Administrator, right-click the 
DeltekTimeAndExpense1000WebTier.exe file in Windows Explorer and select Run as 
Administrator. 
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4. On the Select Deltek Costpoint 7.1.1 Web Server Directory screen, click Browse to navigate to 
an installation location for the Deltek Costpoint 7.1.1 IIS software.  

The default is C:\Deltek. 

5. Click Next >. 

6. On the Pre-Installation Summary screen, review the installation parameters you have selected: 

 If you want to change any settings, click < Back to go back and make the necessary 
changes.  

 If you are satisfied with these settings, click Install > to begin the installation. 

Once initiated, the installation process can take a long time to complete. Please do not interrupt 
the process.  

The installation will perform the scenarios detailed in the Installation Process for Time & Expense 
10.0.0 section of this document.  

The installation process creates the CPWeb Virtual Directory under the Default Website, using 
the Default App Pool. The process also creates a share of your Time & Expense 10.0.0 Costpoint 
directory, C:\Deltek\Costpoint\71\applications. In order for the Application Server (WebLogic) to 
deploy hot fixes and updates, this directory must be shared with Co-Owner (Full Control) rights. 

7. On the InstallShield Wizard Complete screen, select the Yes, I want to view the log file check 
box to open the DeltekTimeAndExpense1000WebTierInstallLog_<date>_<time>.txt file from the 
C:\Program Files\Deltek\Time & Expense\10.0.0\Logs directory. This check box is selected by 
default. 

8. Click Finish to exit the installation. 

9. When the DeltekTimeAndExpense1000WebTierInstallLog_<date>_<time>.txt file opens, search 
for the following keywords: 

 “Error”: Report any search results to Deltek Time & Expense Technical Support. 
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Time & Expense 10.0.0 Initial Log In 
Configuration 
The steps to configure your browser and verify your Time & Expense 10.0.0 Application Tier and Web 
Tier installations are detailed in this section. To confirm that these servers are functioning properly, you 
will log in to Time & Expense 10.0.0 and preview a report. 

Before You Start 
Make sure that you meet all Time & Expense 10.0.0 Initial Login Configuration Prerequisites. 

Time & Expense 10.0.0 Printer Configuration 
This step is optional. It provides configuration instructions for your Application Tier WebLogic Server to 
allow you to print Time & Expense 10.0.0 reports. This is useful for asynchronous printing from the server, 
especially for tasks such as printing reports through the Job Server in the middle of the night. 

 
You must perform this step on your Time & Expense 10.0.0 application server. 

To create Windows printer objects on your application server: 

1. Click Start » Printers and Faxes. For Windows Server 2012, right-click Start, select Control 
Panel, and under Hardware, select View devices and printers. 

2. On the Printers and Faxes screen, double-click Add Printer. 

3. Use the Add Printer Wizard to create a Windows printer object that will connect and print to a 
printer on your network. 

On your application server, you can create as many Windows printer objects as needed for your 
organization. After the printer objects are created, your Time & Expense 10.0.0 WebLogic application 
server will make the printer objects available to your users. 

Set Web Browser Internet Options 
The steps to configure the Internet Explorer (IE) browser settings to access the Time & Expense 10.0.0 
system are detailed in this section. 

This step must be performed on all Windows client workstations that will access your Time & Expense 
10.0.0 WebLogic application server. 

To configure the browser settings for accessing the Time & Expense 10.0.0 system: 

1. Open your Web browser. From the menu bar, click Tools » Internet Options. 

2. On the Internet Options screen, click the General tab, and click Settings under the Browsing 
history section. 

3. On the Temporary Internet Files and History Settings screen, complete the following: 

Note: Users can print to local printers from the workstations without configuring anything in this step. 
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Field Name Action 

Check for newer 
versions of stored 
pages 

Select Automatically. 

Disk space to use Enter at least 100 Megabytes (MB). 

4. Click OK to close the Settings screen. 

5. On the Internet Options screen, click the Security tab, and click Trusted sites » Sites. 

Depending on your environment, you may need to add your Time & Expense 10.0.0 URL under 
Local Internet instead of Trusted sites. 

6. On the Add this website to the zone, enter http://<IPAddress or ComputerName>, where 
<IPAddress or ComputerName> identifies your Time & Expense 10.0.0 WebLogic application 
server or IIS Web server, depending on which server you will be using to access Time & Expense 
10.0.0 (for example, http://10.2.2.154). 

7. Clear the Require server verification (https:) for all sites in this zone check box. 

8. Select the check box, and click Add. And then, click Close. 

9. On the Internet Options screen, click the Advanced tab, scroll down under the Browsing section, 
and clear the Reuse windows for launching shortcuts check box. 

10. Click OK to close the Internet Options screen. 

11. From the menu bar, click Tools » Pop-up Blocker » Turn Off Pop-up Block. 

Disable any pop-up blockers or explicitly allow pop-ups for the Time & Expense 10.0.0 URL, such 
as http://<IPAddress or ComputerName>, where <IPAddress or ComputerName> identifies 
your Time & Expense 10.0.0 WebLogic application server or IIS Web server (for example, 
http://10.2.2.154). 

12. Close your Web browser. 

Log In To Time & Expense 10.0.0 
The steps to log in to Time & Expense 10.0.0 are detailed in this section. 

You can perform this step from any Windows client workstation that has TCP/IP access to your Time & 
Expense 10.0.0 WebLogic application server. 

To log in to Time & Expense 10.0.0: 

1. Open your Web browser, and enter one of the following URLs: 

 http://<AppServerIPAddress or ComputerName>:<Port> 

 http://<WebServerIPAddress or ComputerName>/cpweb 

Where <AppServerIPAddress or ComputerName> identifies your Time & Expense 10.0.0 
WebLogic application server and <Port> identifies the unique port number that your Time & 
Expense 10.0.0 WebLogic application server uses to listen for connections. You specified this 
port value during the Time & Expense 10.0.0 software installation. The default is 7009 (for 
example, http://10.2.2.154:7009). 

Or where <WebServerIPAddress or ComputerName> identifies your Time & Expense 10.0.0 IIS 
Web server (for example, http://10.2.2.156/cpweb). 

http://10.2.2.154/
http://10.2.2.154/
http://10.2.2.154:7001/
http://10.2.2.156/cpweb
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2. When the Deltek Costpoint 7 Welcome screen displays, complete the following: 

Field Name Action 

Username Enter CPSUPERUSER. 

Password Enter password. The password is case-sensitive and must be entered in 
lowercase. Passwords that you create for other user IDs may be 
uppercase, lowercase, or mixed. 

System Enter <Your_System_Name>, where <Your_System_Name> identifies 
the system name you assigned to your Time & Expense 10.0.0 system 
during the Application Server Installation. Typically, customers use a 
system name that is identical to their Time & Expense 10.0.0 Database 
name, DELTEKCP. 

SHOW 
ADDITIONAL 
CRITERIA 

Click + to display these additional fields: 

 Application: Accept the blank default value, or enter a specific Time 
& Expense 10.0.0 application (for example, COSTPOINT MENU). 

 Company: Enter your company ID (for example, 1). 

 Validation Frequency: Accept the default drop-down value, Field. 
After you have successfully logged in to Time & Expense 10.0.0, 
review the online help for a detailed explanation of the value you can 
select for this field. 

Remember log in 
information 

Select this check box to have the system remember your login 
information. This check box is not selected by default. 

3. Click Log In. 

4. Contact Custom Solutions at Deltek if the following message displays: “Warning: The custom 
programs and the database version are not compatible. The custom programs may not work 
properly. Please contact Custom Solutions at Deltek. Do you want to continue with the login?” 

5. Click OK and a screen similar to the sample shown below displays: 
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6. From the main menu screen, click Administration » System Administration » System 

Administration Utilities » Rebuild Global Settings. 

 
7. On the Rebuild Global Settings screen, click Default Action. 
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8. On the Processing Complete screen, click OK. 

9. Select File » Close Application to close the Rebuild Global Settings screen. Click OK on the 
unsaved changes message. 

10. From the main menu screen, click Administration » System Administration » Printing » 
Manage System Printers. 

Note: If you click the right side (down arrow) of the Default Action button, you must also 
select Reload Settings. 
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11. On the Manage System Printers screen, click New Record (+).  

 
12. Complete the following fields: 
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Field Name Action 

Printer ID Click  to display all printer objects that are available on your 
Application Server. To select the appropriate printer object, click the 
check box to the left of the printer object name and clicking SELECT. 

Printer Name Enter a descriptive name for the printer object. 

13. Select the Assigned Users/User Groups link located in the lower right corner of the System 
Printers section. 

14. When the focus switches to the Assigned Users/User Groups section at the bottom half of your 
browser window, click New Record (+), and complete the following fields: 

Field Name Action 

User/User Group 
ID or User/User 
Group Name 

Click  for one of these fields. Select a User/User Group that should 
have access to the printer object you specified above. 

Company Click  and select a Company for this User/User Group. 

15. Click SELECT. You must repeat Step 14 for each User/User Group that you want to assign the 
printer object that you specified in Step 12. 

16. Click Save. Click OK when the following message displays: “Record modifications completed 
without error.” 

You must repeat steps 12–16 for any printer objects on your Application server that you want to 
make available to your Time & Expense 10.0.0 system users. 

17. Click File» Log-out to exit Time & Expense 10.0.0.  

18. Close your Web browser. 

Verify Time & Expense 10.0.0 Printer Configuration 
The steps to verify your Time & Expense 10.0.0 printers are detailed in this section. 

This step can be performed from any Windows client workstation that has TCP/IP access to your Time & 
Expense 10.0.0 WebLogic application server. 

To verify your Time & Expense 10.0.0 printers: 

1. Open your Web browser, and enter one of the following URLs: 

 http://<AppServerIPAddress or ComputerName>:<Port> 

 http://<WebServerIPAddress or ComputerName>/cpweb 

Where <AppServerIPAddress or ComputerName> identifies your Time & Expense 10.0.0 
WebLogic application server and <Port> identifies the unique port number that your Time & 
Expense 10.0.0 WebLogic application server uses to listen for connections. You specified this 
port value during the Time & Expense 10.0.0 software installation. The default is 7009 (for 
example, http://10.2.2.154:7009). 

Or where <WebServerIPAddress or ComputerName> identifies your Time & Expense 10.0.0 IIS 
Web server (for example, http://10.2.2.156/cpweb). 

http://10.2.2.154:7001/
http://10.2.2.156/cpweb
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2. On the Deltek Costpoint 7 Welcome screen, complete the following fields: 

Field Name Action 

Username Enter CPSUPERUSER. 

Password Enter the CPSUPERUSER user password. The default is password. 

System Enter <Your_System_Name>, where <Your_System_Name> identifies 
the system name you assigned to your Time & Expense 10.0.0 system 
during the Application Server Installation process. Typically, customers 
use a system name that is identical to their Time & Expense 10.0.0 
Database name, DELTEKCP. 

SHOW 
ADDITIONAL 
CRITERIA 

Click + to display these additional fields: 

 Application: Accept the blank default value, or enter a specific 
Time & Expense 10.0.0 application (for example, COSTPOINT 
MENU). 

 Company: Enter your company ID (for example, 1). 

 Validation Frequency: Accept the default drop-down value, Field. 
After you have successfully logged in to Time & Expense 10.0.0, 
review the online help for a detailed explanation of the value you 
can select for this field. 

Remember log in 
information 

Select this check box to have the system remember your login 
information. This option is not selected by default. 

3. Click Log In.  

4. Click OK if the following message displays: “Warning: The custom programs and the database 
version are not compatible. The custom programs may not work properly. Please contact Custom 
Solutions at Deltek. Do you want to continue with the login?”  

5. From the main menu screen, click Administration » Security » Security Reports/Inquiries » 
Print User Group Rights Report. 
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6. On the Print User Group Rights Report screen, click Print Options. 

 
7. On the Print Options screen, select the System Printer or the Local Printer Delivery Option, 

depending on how you set up your Application Server printer. Then, click OK. 

8. On the Print User Group Rights Report screen, click Print Default Report. 
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If the User Group Rights Report prints correctly, then your Time & Expense 10.0.0 Application 
Server printer setup is working properly. If the report does not print correctly, please contact 
Deltek Time & Expense 10.0.0 Technical Support. 

9. Click File » Close Application to close the Print User Group Rights Report screen. 

10. Click OK when the following message displays: “You have unsaved changes. Select Cancel to go 
back and save changes or select OK to discard changes and close the application”.  

11. You can now begin to configure and use the Time & Expense 10.0.0 system. Please refer to the 
Related Documentation section for a list of all documentation included with the Time & Expense 
10.0.0 release. 



Post-Installation Configuration 

New Installation Guide for Oracle® 41 

 

Post-Installation Configuration 

Apply Latest Time & Expense 10.0.0 Hot Fixes 
Updates to Time & Expense 10.0.0 will be released in a Cumulative Update installer. 

Once you have a functioning Time & Expense 10.0.0 environment, follow the 
DeltekTimeAndExpense1000DeployingHotFixes.pdf installation document to install the latest Time & 
Expense 10.0.0 hot fixes. 

Troubleshooting Instructions 
Troubleshooting instructions for problems with the Database Tier installation are detailed in this section. 

How to Remedy a New Database Tier Installation That Failed 
The steps to repair a Time & Expense 10.0.0 Database Tier installation that has failed are detailed in this 
section. 

If you encounter a failure during the Database Tier installation process: 

1. Click OK if, during the Database Tier Installation, you receive the following error message: “Failed 
to create Time & Expense TRANSACTION Database”  

 
2. After the installation has stopped and a failed installation error message displays on the 

InstallShield Wizard Complete screen, select the Yes, I want to view the log file check box. This 
opens the DeltekTimeAndExpense1000DatabaseTierInstallLog_<date>_<time>.txt file from the 
C:\Program Files\Deltek\Time & Expense\10.0.0\logs directory).  

3. Click Finish to exit the installation. 

4. When the DeltekTimeAndExpense1000DatabaseTierInstallLog_<date>_<time>.txt file opens, run 
a search for the “error” search string. Report all errors found to Deltek Time & Expense Technical 
Support. 

Under error conditions on new installs, the installer does not provide an option to restart. One of 
several actions might be required. 

5. After performing the required actions from Technical Support, perform the following: 

 From Programs and Features (Add/Remove Programs) select Deltek Time & Expense 
10.0.0 Database and click Uninstall. 

 Proceed to the Database Tier Installation section at the beginning of this document and 
restart this installation at the Install Database Tier Software step. 
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Latest Upgrade Files Download Instructions 
The Time & Expense Database Tier installer provides certain command-line options that can be invoked 
in special circumstances. To display the currently supported switches: 

 Open Command Prompt in Administrator Mode 

 Navigate to the directory where the installer is located 

 Type DeltekTimeAndExpense1000DatabaseTier.exe /? 

The instructions to download the latest Time & Expense 10.0.0 Database upgrade and 
DeltekTimeAndExpense1000RequirementsINI files are detailed in this section. Each installer will 
automatically download the applicable files if your servers have internet access. If your servers do not, 
you will need to run this step for each installer. 

You must perform this step on any machine that has Internet access. 

To download the required upgrade files: 

1. Run the applicable command to retrieve the files from DSM: 

DeltekTimeAndExpense1000DatabaseTier.exe /filedynamicdownload 

DeltekTimeAndExpense1000ApplicationTier.exe /filedynamicdownload 

DeltekTimeAndExpense1000WebTier.exe /filedynamicdownload 

You will see the following screen. 

  
2. After the file downloads a message similar to the following displays, click OK. 
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3. Copy the downloaded DeltekTimeAndExpense1000DatabaseUpgradeFiles.exe/ 
DeltekTimeAndExpense1000RequirementsINI.exe file(s) to your server, in the same folder as 
your ‘.exe’ installer file.  

 

 



 

 

About Deltek 
Better software means better projects. Deltek is the leading global provider of enterprise software and 
information solutions for project-based businesses. More than 23,000 organizations and millions of users 
in over 80 countries around the world rely on Deltek for superior levels of project intelligence, 
management and collaboration. Our industry-focused expertise powers project success by helping firms 
achieve performance that maximizes productivity and revenue. www.deltek.com 

http://www.deltek.com/
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